Contents

Preface

1 About This Guide  1
   Audience and Scope  1
   Related Guides  1

2 Working with Service Requests  3
   Creating and Editing a Service Request  3
   Creating and Editing Action Plans  18
   FAQs about Action Plans  21
   Viewing Service Request Details  21
   Inserting Knowledge in Service Requests  23
   Using Productivity Tools  26
   Managing Service Requests on Mobile  28

3 Working with Queues  31
   Managing Queues: Procedure  31
   Adding Resources and Resource Teams to a Queue  33
   Queues Dashboard: Explained  34
   Reassigning and Rerouting of Interactions: Procedure  37

4 Managing Notifications and Interactions  39
   Using Chat  39
   Handling CTI Notifications  40
   Setting Agent Availability and Presence  42
   Bell Notifications for Service Requests  43
## 5 Managing Work Orders

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Orders: Overview</td>
<td>45</td>
</tr>
<tr>
<td>Creating a Work Order: Procedure</td>
<td>45</td>
</tr>
<tr>
<td>Updating a Work Order: Procedure</td>
<td>46</td>
</tr>
<tr>
<td>Rescheduling a Work Order: Procedure</td>
<td>46</td>
</tr>
<tr>
<td>Canceling a Work Order: Procedure</td>
<td>47</td>
</tr>
<tr>
<td>Viewing Audit History for a Work Order</td>
<td>47</td>
</tr>
</tbody>
</table>

## 6 Using Service Analytics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Analytics: Explained</td>
<td>49</td>
</tr>
<tr>
<td>Using Service Analytics: Explained</td>
<td>51</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help

Use help icons to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community:** Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- **Guides and Videos:** Go to the Oracle Help Center to find guides and videos.

- **Training:** Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 About This Guide

Audience and Scope

This guide is intended for users who are involved in creating and managing service requests. The activities in this guide are only available if the implementation tasks for Oracle Engagement Cloud are complete.

Related Guides

To understand more about the information covered in this guide, you can refer to the list of guides in the following table.

<table>
<thead>
<tr>
<th>Guide</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Engagement Cloud Knowledge</td>
<td>Describes how administrators, agents, authors, and other knowledge base contributors can implement and use Knowledge in Engagement Cloud.</td>
</tr>
<tr>
<td>Oracle Applications Cloud Using Common Features</td>
<td>Provides an overview of the application functionality that is common across the applications</td>
</tr>
<tr>
<td>Oracle Sales Cloud Using Analytics and Reports</td>
<td>Contains information about supplied reports and analytics, as well as how to create your own reports.</td>
</tr>
<tr>
<td>Oracle Sales Cloud Using Customer Contracts</td>
<td>Contains information to help end users who are charged with creating and managing customer contracts.</td>
</tr>
<tr>
<td>Oracle Sales Cloud Using Sales</td>
<td>Contains information to help sales managers, sales people, and other sales end users when using Oracle Sales Cloud to perform their day-to-day tasks.</td>
</tr>
</tbody>
</table>

Related Topics

- Oracle Help Center
2 Working with Service Requests

Creating and Editing a Service Request

Managing Service Requests: Overview

Service request management involves the following tasks:

- Capturing Service Requests (SRs)
- Organizing and assigning SRs
- Managing the life cycle of an SR

You can capture new SRs in the following ways:

- User data entry
- APIs
- File import

You can organize and assign SRs as follows:

- Assign SRs to queues either manually or using the Assignment Manager.
- Assign SRs to team members through the **Assign To** field in the SR page.
- Assign SRs using Omnichannel to queues and agents. For more information about queues, see the help topics related to queues and routing.

An SR typically moves through the statuses: New, Waiting, In Progress, Resolved, and Closed. You must know the following about an SR life cycle:

- You must have sufficient privileges to update the SR status. You can reopen a closed SR only if you have the Update privilege.
- Whenever the SR status is set to Resolved, the Resolved Date is set to the current date.
- If you move an SR from the Resolved status to any status other than Closed, then you must set the Resolved Date to blank.
- If you move an SR that isn’t in Resolved status to Closed status, then set the Resolved Date to the current date.
- If you move an SR from the Resolved status to any type other than Closed, then set the reopen date to the current date.

You can review the milestones on an SR and get notifications when you reach, complete, or pass a milestone.

*Note:* You can modify the SR statuses according to your requirements if you have sufficient privileges.

**Related Topics**

- Managing Queues: Procedure
- Queues Dashboard: Explained
Creating and Editing a Service Request

Video

Watch: This video tutorial shows you how to create and edit service requests. The content of this video is also covered in text topics.

Procedure

You can edit or create a service request (SR):

- From the Navigator. To do this, select the Service Requests menu from the Navigator page, and on the Service Requests list page, click an existing SR to edit, or click Create Service Request to create a new SR.
- From the Edit Account or Edit Contact page, by clicking the Service Request menu option. The Service Requests page opens with a list of SRs that are associated with the account or contact. Click a service request to edit, or click Create Service Request to create a new SR.

If you open a new service request page from an existing account or contact, the fields are automatically populated in the Create Service Request page.

To create service requests for partner accounts, see the topic Creating and Editing Service Requests for Partners.

Note: To change a Create or Edit Service Request page from a modal window to a dynamic tab, click Actions and then select Switch to Service Request Workspace.

Creating or editing an SR involves the following steps:

- Entering the summary information: The summary information contains details of what the service request is about, such as the customer account, primary contacts, SR description, and so on.
- Viewing Interaction History: The interaction history tab gives details about the various interactions an agent has had for a service request. It displays details on who called whom, through what communication channel, what were his top interactions, and with what customer. The view always shows the parent interaction with the associated child interactions (including the cross-channel interactions) in a nested view under the parent interaction. To view the associated interactions, click the + icon next to the parent interaction.
- Composing messages: View, create, and send messages and notes on the SR using this tab.
- Adding contacts: Add customer contacts to the SR.
- Adding team members: Add team members who can view and work on the SR.
- Creating activities: Create activities such as appointments, tasks, and log calls with the customer.
- Using Oracle Social Network: Use the Oracle Social Network to collaborate with other resources in the team on the SR.
- Viewing linked articles: View related knowledge articles that can help resolve the SR.
- Viewing Service Request Milestones: View the service milestones for the SR.
- Managing Work Orders: Manage your work orders to facilitate resolution of the SRs.
- Viewing Audit History: View the audit history for the service request based.
Using Dynamic Tabs and Nested Dynamic Tabs

You can manage multiple open SRs without confusion by grouping the SR with its associated objects under a single dynamic tab. The primary tabs display instances of objects such as SRs, Queues, Contacts, and Accounts. When you have an open record and then open another record associated with the initial record, the record is shown as a nested tab of the primary record. For example, when you open an SR, it opens in a dynamic tab, with the SR details shown in a nested tab. The maximum number of dynamic tabs that you can open at one time is 10.

You can use the nested dynamic tabs to manage multiple related objects of the SR without confusion. The nested tabs enable better support for multiple interaction agents such as chat agents, and help increase agent productivity. The maximum number of nested tabs that you can open at one time is 5. Under each open top-level dynamic tab, you can open the following objects as nested tabs:

- Account
- Contact
- Asset
- Custom Object
- Other Service Requests

Nested tabs enable you to quickly and easily navigate across and between grouped records without losing context. To open an associated record as a nested tab, click the object link that can be opened as a nested tab in the service work area. When you open a record in a nested tab, that record automatically becomes the active tab.

When you try to close an unsaved nested tab, a warning message appears to let you know that there are unsaved changes.

You can close the top-level dynamic tab and all the nested tabs at one time by clicking the x icon on the top-level dynamic tab name. When you try to close a dynamic tab with unsaved changes in its nested tabs, a warning message appears to let you know that there are unsaved changes.

Using the Actions Menu

In addition to the dynamic and nested tabs, you can take action on the SR from the Actions menu on the Edit Service Request screen. The following table lists and describes the actions available in the Actions menu.

<table>
<thead>
<tr>
<th>Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolve</td>
<td>Displays the Resolve Service Request dialog box. This feature enables you to enter simple and consistent resolution information about the SR.</td>
</tr>
<tr>
<td>Assign to Me</td>
<td>Assigns the SR to you.</td>
</tr>
<tr>
<td>Copy</td>
<td>Creates a new SR with the same details as the current SR.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the SR.</td>
</tr>
<tr>
<td>Forward</td>
<td>Forwards the SR to another user in the application.</td>
</tr>
<tr>
<td>Internal Note</td>
<td>Creates an internal note on the SR in the Messages tab.</td>
</tr>
<tr>
<td>Response</td>
<td>Creates a response message in the Messages tab.</td>
</tr>
<tr>
<td>Get Link</td>
<td>Copies the link to the SR. You can paste this link in your messages or use it to access the SR directly on the browser.</td>
</tr>
</tbody>
</table>
## Working with Service Requests

### Actions

<table>
<thead>
<tr>
<th>Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Queue Assignment</td>
<td>Assigns the SR to a queue immediately.</td>
</tr>
<tr>
<td>Update Service Request Milestones</td>
<td>Updates and refreshes the SR milestones.</td>
</tr>
<tr>
<td>Launch cobrowse</td>
<td>Launches a cobrowse session with the customer. The cobrowse feature enables you to see the customer’s screen and what they are working on. This feature is available only if it’s configured by your administrator.</td>
</tr>
</tbody>
</table>

### Resolving a Service Request

The **Resolve Service Request** dialog box is used to enter simple and consistent resolution information of the SR such as outcome, resolution code, and solution description in one place. This dialog is automatically populated with information that you have already entered in the SR.

1. From the **Edit Service Request** page, click **Actions** and select **Resolve**.
   
   This displays the **Resolve Service Request** dialog box for you to enter a solution in preparation for resolving the Service Request.
2. Select the **Outcome** from the drop-down list that best describes the outcome of the service request.
3. Select a **Resolution Code** from the drop-down list that contains detailed reporting codes describing how the chosen Outcome was achieved. The options available in this list are dependent on the value you selected in the Outcome list.
4. Enter the details explaining about the solution of the problem up to a maximum of 1000 characters in the **Solution Description** field. You can use a SmartText entry here.
5. Click **Resolve**.

The information captured in the **Resolve Service Request** dialog box appears in a new Solution section in the Summary page. The Solution description field is available throughout the lifecycle of the SR, so you can prepare notes and draft descriptions validate them before the Service Request is formally Resolved. The section also displays additional fields, **Resolved By** (the name of the agent who resolved the SR) and **Resolution Date** (date and time of the SR resolution) in this section.

### Using Cobrowse

Cobrowse provides the ability to have the same view as the customer, and review their issue. The cobrowse functionality must be enabled with both the customer portal and Engagement Cloud.

1. From the **Edit Service Request** page, click **Actions** and select **Launch cobrowse**.
   
   After you launch the cobrowse functionality from the Service workspace, instruct the customer to launch the request live assistance functionality from the website that they are on currently. This request by the customer generates a security code which they can share with you. By providing this code to you, the customer is verbally allowing you to view their screen.
2. Enter your first and last name and the code provided by the customer in the new console window that opens.
3. Click **Connect**.

### Related Topics

- Creating a Work Order: Procedure
Entering Service Request Summary Details

Enter the required information for all the fields along with a detailed description of the SR (the problem description, symptoms, and additional information) in the Summary area. While some of the fields are self-explanatory, the following table lists and describes the fields required in the summary information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Select the account associated with the service request.</td>
</tr>
</tbody>
</table>
| Primary Contact | Select the primary contact for the account that you selected. To save the SR, the account and the primary contact you select must be related to each other. Depending on your selection, the following occurs:  
  - If you select an account, then only contacts of that account are listed for search.  
  - If you do not select an account, then all contacts are available for search.  
  - If you attempt to change an account after selecting a primary contact, a message is displayed confirming the deletion of the invalid contacts associated with the service request. If you select Yes, the contacts associated with the account are deleted. |
<p>| Severity    | Select the SR severity.                                                     |
| Critical    | Select this option to include the service request in the reporting metrics about critical SRs. It doesn’t affect the service request resolution. |
| Category    | Select an SR category.                                                     |
| Product     | Select the product group or product that is associated with the SR.        |
| Queue       | Select a queue to which the SR is assigned.                                |
| Assigned To | Select the resource that owns the service request and appears as the primary member of the SR team. This field is available only to users with the Service Request Troubleshooter duty role, Service Request Power User duty role, and Service Request Channel User duty role. The field is not available to users with Contributor role, such as sales representative. |
| Channel Type | Select a channel through which the SR is sent to the customer support. You can select Email, Phone, or Web channel. |
| Status      | You must have the Status Update privilege to change the SR status.         |
| Problem Description | The problem description contains details of the problem that you’re creating the SR for. You can use a SmartText entry here. |
| Attachment  | Add an attachment to the SR by selecting a file type, browsing, and uploading an attachment to the SR. If the category field is available, select Miscellaneous category for attachments that you want |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution Description</td>
<td>The Solution Field description is available throughout the lifecycle of the SR. You can prepare notes and draft descriptions, and validate them before you formally resolve the SR. You can use a SmartText entry here.</td>
</tr>
</tbody>
</table>

**Note:** If you’re using only your keyboard to enter the details on the Summary page, to select the value in the Category and Product fields, do the following:

1. Press tab key until you get to the Product or Category field.
2. Press ALT + Down arrow key to open the list options.
3. Press SHIFT + Tab key to select the Search link and press ENTER.
4. On the Select Product or the Select Category window, press Tab to get to the hierarchy that has the product you want to select.
5. After you select the product or category, press SHIFT + Tab to move out of the table.
6. Press the Down arrow key to highlight the record that you want to select.
7. Press SHIFT + ALT + K to select OK. The product or category is added to the field.

If you have an Asset field enabled on the Summary details, you can associate the required asset from the drop-down list. Assets are specific instances of products that your customers have purchased. They typically have a serial number, date of purchase, date of install, and so on.

If you select an account for the SR, then you can select an asset for that account, using the Asset drop-down list. If you do not select an account but associate a contact with the SR, then you can pick an asset for the contact. If you do not select an account or a contact, you aren’t allowed to select an asset.

When you start creating an SR, the Create Service Request page displays three buttons: Save and Continue, Save and Close, and Cancel. Once you enter a title and save the SR, or open an SR for editing, the page also displays the Actions menu. The following table lists and describes the available actions in the Actions menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolve</td>
<td>Select this option to enter simple and consistent resolution information about the SR.</td>
</tr>
<tr>
<td>Assign to Me</td>
<td>Select this option to assign the SR to yourself.</td>
</tr>
<tr>
<td>Copy</td>
<td>Select this option to make a copy of the SR and to create an SR.</td>
</tr>
<tr>
<td>Delete</td>
<td>Select this option to delete an SR. This option is available only to administrators.</td>
</tr>
<tr>
<td>Forward</td>
<td>Select this option to forward the SR to another user of the application.</td>
</tr>
<tr>
<td>Run Queue Assignment</td>
<td>Select this option to assign a queue to the SR.</td>
</tr>
</tbody>
</table>
Adding Contacts to a Service Request

You can add one or more contacts to the service request. The contacts added to a service request can view and update the service request.

To add a contact to the SR,

1. Click the Contacts subtab.
2. Click Add Contacts.
3. If relevant contacts exist in the database, then enter the search criteria, and select one or more contacts to associate with the SR. Click Apply to add them to the list of contacts.
4. If relevant contacts do not exist in the database yet, click Add Contact and then click Create Contact. For more information about creating a contact, see Oracle Sales Cloud Using Sales Guide.
5. After adding the required contacts, click OK to return to the SR page.

Note: You can make one of the contacts the primary contact by clicking the contact under Primary. You can change the primary contact by clicking a different contact under Primary, but you can’t delete a primary contact. The Delete option is disabled for the primary contact.

Adding a Primary Contact to a Social Service Request

For social service requests, the application tries to identify a contact from the social handle of the post author. If you associate a social SR with a primary contact, the Create Contact Point dialog box is displayed. If you click Create, the social handle of the post author is added as a contact point of the primary contact. Once a social contact point exists for a contact, all SRs created for social posts from that user are associated with a primary contact.

Adding Team Members to a Service Request

The Team tab on the Edit Service Requests page lists the members of the team that are working on the SR. The Assigned column is checked for the user who is currently assigned the SR. You can view, add, and remove team members to the team list. You can’t remove the user who is currently assigned to the SR.

The following procedure describes how to add team members to an SR.

1. On the Team tab, click Add Team Members.
2. On the Add Team Members page, search for the user that you want to add.
3. Select one or more users that you want to add from the Search Results section.
4. Click Apply to add the users to the team.
5. Click OK to close the Add Team Members page.

After you add users to the team, you can assign the SR to a specific user by selecting the Assigned To column for the user.

Creating Activities in a Service Request

Keep track of things that you plan to do for the SR in the Activities tab. You can create a task, an appointment, or log a call that you have already completed as a part of the solution for the service request.
You can create and maintain the following activities from the **Activities** tab in the **Edit Service Request** page:

- Tasks are to-do items assigned to people or groups, and also used to record completed customer interactions that were not scheduled in your calendar as appointments.
- Appointments are calendar events (for example, a meeting with another person, or a scheduled phone call).
- Log a call to record a brief summary of a call that was made for the SR. Calls can be created from an appointment, a task, or standalone from the Activity list page. When created from a task or appointment, all pertinent data is auto-populated onto the call report.

For more information about creating activities, see **Maintaining Calendar and Activities** in the Oracle Sales Cloud documentation.

**Related Topics**

- **Activities: Explained**
- **Maintaining Calendar and Activities**

### Composing Messages in a Service Request

You can compose and send messages to customers or team members using the **Messages** tab on the **Edit Service Request** page.

The following table describes the type of messages you can create for an SR.

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Entry</td>
<td>Customer entries capture the information that the customers provide to explain their service problem or question. Depending on the input channel, this information is written directly by the customer, or transcribed by the agent while interacting with the customer.</td>
</tr>
<tr>
<td>Forward</td>
<td>You can forward a customer response or query to any other user of the application through web, email, or phone, depending on the type of the SR.</td>
</tr>
</tbody>
</table>

While forwarding an Email type of an SR, the agent can select a mailbox or an email channel to which the message must be sent, by using the **Channel** drop-down list. An agent can select the recipients of the message using the **To**, **CC**, or **BCC** drop-down lists.

| Internal Note | SR owners can use internal notes to communicate with other team members who have access to the SR. |
| Response | You can compose a response message to communicate with the SR contacts. You can send the response to the contact in an email template, or post it to another channel through an application programming interface (API). |

While composing a response an agent can select the mailbox or the channel by using the **Channel** drop-down list.

All the social posts display the customer’s social media profile picture. Click the social profile icon to display the number of followers on the social network for that profile. If your social post message on an SR is public, you can only respond with a public message. If the incoming social post from the user is private, you can only send a private response to the user. However, if you have both a public and private social post from the user, you can choose whether to respond with a public...
or a private post. For posts that require character limit to be enforced, you can use application composer and add a script to validate the maximum number of characters in your response.

Note: For social posts where a social channel response is disabled, you can change the channel type to email in your response message, as the channel type social is disabled.

For inbound messages, photos and videos attached to social posts in Oracle Social Cloud are displayed under the Customer Entry messages for an SR. Inbound messages of this type are supported for public and private messages on both Facebook and Twitter social networks. These attachments are URLs that you can click and view:

- For public messages, when you click the URL attachment, it opens Facebook or Twitter, where you can see the attachment image or video.
- For private messages, when you click the URL attachment, it opens Social Cloud. You must sign in to Social Cloud to see the attachment image or video.

When you compose a new message, you can use SmartText entries and knowledge articles in your message text, and add attachments as part of the message. You can also sort your messages using the different filters available in the Filter Bar. The following procedure describes how to compose a message.

1. On the Messages tab, select Compose and select the type of message that you want to create.

   A new message form opens.

2. Depending on the message type that you choose, select the Channel Type, Channel, and select the recipient for the message.

   - For a customer entry, select the customer contact for whom you’re creating this message.
   - For forwarding a message, select the recipient of the message in the To field. You can also add recipients in the carbon copy and blind carbon copy fields for the forwarded message.
   - For creating an internal note, you aren’t required to add recipients.
   - For creating a response, select the channel type and channel.

3. Click the Manage Attachments icon or click Select from Service Request to add an attachment to the message. You can attach a file or a URL to your messages and enter a title and description for the attachment. To attach more than one item, click Add to add a new row in the Attachments dialog.

   Attachments aren’t supported if you are responding through a social channel.

4. Enter the content of the message. You can use rich text formatting in your message content, except for social channel responses. Images and icons are currently not allowed for social responses.

5. To insert a SmartText entry, type the # symbol, then begin typing the SmartText entry name. You can click the Tab key to autocomplete the SmartText name, or use the navigation arrows on your keyboard, then press the Enter key. The SmartText is inserted where the cursor stands in your text.

6. Click Insert Knowledge to insert relevant knowledge articles into the message text.

   Inserting knowledge article links is not supported for responses using the social channel.

7. If the channel type is Email, click Preview Email to preview the message. Preview displays the To, CC, and Reply-to values along with attachments, if any. If the administrator has defined email templates in the application, then preview displays the composed message in the defined format. If no template is defined, preview displays only the message as composed by you.

8. Click Send or Post to send the message.

   If sending an email response fails, you can open the failed response, edit the message if required, and resend the message.
Viewing and Filtering Messages

Once you have composed a message, you can view the message in the Messages subtab. Each type of message is displayed in a different background color and with a different icon to easily identify whether the message was sent by an agent, a customer or is an internal message.

You can filter messages using the Filter tab in the Messages subtab in the following ways:

- Use the Collapse All and Expand All buttons to collapse and expand all the messages with one click.
- Use the toggle button (with the arrow up and down icons) to toggle between the Oldest First and Newest First messages. The Newest First is the default view.
- Use the one-click filter buttons to filter messages based on the following types of messages:
  - Customer: Click the toggle button to view or not view all types of customer messages. Use the drop-down list next to the Customer button to view or not view customer entries, forwards, and responses.
  - Internal: Click the toggle button to view or not view all types of internal messages. Use the drop-down list next to the Internal button to view or not view chat transcripts, internal notes, and wrap ups.
  - System: Click the toggle button to view or not view all types of system messages. Use the drop-down list next to the System button to view or not view system notes and system responses.
- Use the Reset icon button to turns all filters back to on, which is the default state.

Service Request List Management: Explained

You can perform the following tasks from the Service Requests page:

- Finding SRs: Use the Find search box to retrieve service requests by their reference numbers. You can save your search.
- Use the List drop-down list as described in the following table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing all SRs</td>
<td>Select All Open Service Requests.</td>
</tr>
<tr>
<td>Listing all SRs assigned to you and not closed yet (This view is the default.)</td>
<td>Select My Open Service Requests.</td>
</tr>
<tr>
<td>Viewing SRs that you created and in open status</td>
<td>Select Open Service Requests Created By Me.</td>
</tr>
<tr>
<td>Viewing SRs assigned to a queue that includes you as a member</td>
<td>Select Open Service Requests Not Assigned to a Queue.</td>
</tr>
<tr>
<td>Viewing SRs assigned to a team that includes you as a member</td>
<td>Select Open Service Requests Where I Am on the Team.</td>
</tr>
<tr>
<td>Manage columns in the list to show only the details that you want to see.</td>
<td>Select Columns in the View drop-down list and select the columns you want. To add more columns, select Manage Columns in the Columns list.</td>
</tr>
<tr>
<td>Create your own SR lists</td>
<td>Select Create or Edit Lists in the List drop-down list. Use the Advanced Search form to add, edit, or remove the criteria to display SRs.</td>
</tr>
</tbody>
</table>
**Task** | **Action**
---|---
Creating your own searches | Select Create or Edit Lists.  
Performing an advanced search | Click the Show Advanced Search button. For more information about the procedure to do an advanced search, see Doing an Advanced Search in this topic.

- You can perform a mass update of the SR fields using the Update option in the Actions menu as described in the section Performing a Mass Update in this topic.
- Use the Create Service Request option to create an SR. For more information about creating an SR, see "Creating and Editing a Service Request: Procedure".
- Use the View button to modify the columns and search results that you see on your list management screen.

**Performing an Advanced Search**

Advanced search lets you narrow down your search by entering more specific search criteria. For example, if you want to see all the open SRs that are assigned to your subordinates and that are in progress, do the following:

1. Click the Show Advanced Search button.
2. Select All Open Service Requests in the Saved Search field.
3. For the Record Set, select Equals and Assigned to my subordinates.
4. For the Status, select Equals and In Progress.
5. Optionally, click Add to add more search criteria.
6. Optionally, click Save to save the search for future use.
7. Click Search to see the search results.

**Performing Mass Updates on Service Requests**

The following procedure describes how to perform a mass update on the service request list.

1. Select Update under the Actions menu.
2. Select the SRs you want to update. To select multiple SRs, hold down the Ctrl key and select each SR.
3. The Update button shows the number of SRs selected.
4. Click Update to view the Update Service Requests dialog box.
5. Select a field to be updated from the drop-down list and a value for the update.
6. Click Submit to assign the queue to all the selected SRs.

**Creating and Editing SR Lists**

You can create or edit your own lists that you would like to see when you open the Service Requests screen. For example, you can create a list specific to SRs from only those accounts where you are listed as a team member.

The following procedure describes how to create or edit your SR list:

1. On the Service Requests screen, select Create or Edit Lists in the List drop-down list.
2. In the Advanced Search panel, select the saved search that you want to use for the list.
3. Select the attributes and values that you want to see in your list. To add more attributes, click Add and select the attributes that you want to set for the list search. You can reorder the order of these attributes by clicking Reorder.
4. Click Search to view the results.
5. Click Save to save the list and search values for the list.
Diagnosing and Troubleshooting Connected Assets: Explained

This section describes how an agent can diagnose and troubleshoot a connected asset associated with a service request (SR).

Oracle Internet of Things Service Monitoring for Connected Assets enables you to securely connect different types of assets and register their resources and metadata. You can also deploy software applications on your registered assets. For more information about Internet of Things Service Monitoring for Connected Assets, see “Getting Started with Oracle Service Monitoring for Connected Assets” in Related Topics.

When an incident is created in Internet of Things Service Monitoring for Connected Assets for a connected asset, an SR is created in Oracle Engagement Cloud for that connected asset. When the SR is resolved, the incident in Internet of Things Service Monitoring for Connected Assets is also closed. When the asset associated with this SR is connected through an instance of Internet of Things Service Monitoring for Connected Assets, you can diagnose and troubleshoot the asset using the **Connected Asset** tab of the Edit Service Request page. On this tab, you can view information reported by the asset, query the asset for additional information, and remotely execute actions that are available for the asset.

The **Actions and Attributes** group enables you to view the attributes of the connected asset, remotely update the available values, and execute available actions, for troubleshooting and diagnosis. The available actions and attributes vary according to the asset definition in the connected Internet of Things Service Monitoring for Connected Assets instance. For example, a connected refrigerator might have an action defined to cycle the power, and might let you remotely set the attribute for the target temperature to any value between 35 and 39 degrees.

You can do the following:

- To execute an action on the connected asset, select an action from the **Asset Actions** drop-down list, and click **Execute Action**.
- To modify the attribute values, edit the values and click **Update Attribute**.

The **IoT Incident Details** group displays the Internet of Things Service Monitoring for Connected Assets incident details for which this SR is created. Connected assets regularly report status information and other data to the Internet of Things Service Monitoring for Connected Assets application. The Internet of Things Service Monitoring for Connected Assets application uses this data to detect problems indicating a failure has occurred or is imminent, and creates an incident. When connected to Engagement Cloud, the incident triggers the creation of an SR to proactively resolve the issue.

The **Diagnostics** group enables you to review the data reported from the asset in a line graph, and identify anomalies that might indicate the cause of the issue. For example, with a connected refrigerator, you might notice that the temperature started increasing a few data points after the motor slowed to half speed. Reviewing this data enables you to focus on why the motor slowed, as the root cause of the issue. You can view up to 200 data points at a time in the line graph, as follows:

- To view data for a specific duration, enter or select the start date and time from which you want to view the data, in the **Display 200 Data Points From** field.
- To navigate to the previous and next set of 200 data points, click the **Previous** and **Next** arrow icons.
- To view the earliest available diagnostic data from Internet of Things Service Monitoring for Connected Assets, click the **Show earliest data** icon.
- To view the latest available diagnostic data from Internet of Things Service Monitoring for Connected Assets, click the **Show most recent data** icon.
- To view the data stream centered on the time the incident was created in Internet of Things Service Monitoring for Connected Assets, click the **Show data from time of incident creation** icon.
- To hide an attribute within the graph, click the attribute name on the graph. To view the attribute, click the attribute name again.
Creating Service Requests for Partners: Explained

You can create service requests to capture and resolve issues reported by your partner accounts. This procedure assumes that you have implemented the partner service request process using the standard roles: partner sales representative, customer service representative, and channel account manager.

A partner SR has the following limitations:

- You can't add partner resources to the SR Team.
- You can't assign the SR to a partner resource.
- You can't use a single SR to communicate to both a customer and a partner.

To create a partner SR, you can do one of the following:

- Select **Service Requests** from the Navigator. On the Service Requests list page, click **Create Service Request**.
- On the **Partner Overview** page, select **Service Requests**, and click **Create Service Request** on the **Service Requests** tab.

Creating and editing a service request for a partner contains the following steps:

- Entering summary information
- (Optional) Composing messages
- (Optional) Adding contacts
- (Optional) Creating a team
- (Optional) Creating activities
- (Optional) Viewing linked articles
- Viewing milestones

> **Note:** External resources (partner sales representatives or partner contacts) can only view the **Summary** and **Messages** tabs. Access to all other SR subtabs is provided only to the internal resources (customer service representative or channel account manager) who work on the SR.

Entering Summary Information

The summary details for your service request capture the basic information required for the service teams to understand the problem. The administrator must configure the layout of this form to include partner-specific fields.

While some of the fields are self-explanatory, the following table lists and describes the fields in the summary information section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Select the product group or product associated with the SR.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Partner Account</td>
<td>For a partner user, the Partner Account field is set by default to the account that the user represents. If this field is not already set, select a partner from the list. This field is mandatory.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>When you associate a partner account with the SR, the Primary Contact field is the partner contact associated with the partner account.</td>
</tr>
<tr>
<td></td>
<td>If this field isn’t automatically set, then search and select a partner contact.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Don’t create a new partner contact from the search dialog box. To create a new partner contact, go to the Partner Administration user interface.</td>
</tr>
<tr>
<td>Severity</td>
<td>Indicates the severity of the problem.</td>
</tr>
<tr>
<td>Critical</td>
<td>Select this option to include the service request in the reporting metric about critical SRs. It doesn’t affect the service request resolution.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates whether the SR status is new, in progress, resolved, or waiting. When you create a new SR, the status is set to New. When editing an SR, you can change the status only if you have the Status Update privilege assigned to your role.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Enter a description for the problem. You can use a SmartText entry here.</td>
</tr>
<tr>
<td>Solution Description</td>
<td>The Solution Description field is available throughout the lifecycle of the SR. You can prepare notes and draft descriptions, and validate them before you formally resolve the SR. You can use a SmartText entry here.</td>
</tr>
</tbody>
</table>

When you start creating an SR, the Create Service Request page displays three buttons: Save and Continue, Save and Close, and Cancel. Once you enter a title and save the SR, or open an SR for editing, the page also displays the Actions menu. The following table describes the actions provided on the Create and Edit SR pages.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign to Me</td>
<td>Select this option to assign the SR to yourself.</td>
</tr>
<tr>
<td>Copy</td>
<td>Select this option to create a copy of this partner SR to create a new SR.</td>
</tr>
<tr>
<td>Delete</td>
<td>Select this option to delete a partner SR. This option is available only to administrators.</td>
</tr>
<tr>
<td>Forward</td>
<td>Select this option to forward the partner SR to any other user of the application.</td>
</tr>
<tr>
<td>Run Queue Assignment</td>
<td>Select this option to immediately assign the SR to a queue.</td>
</tr>
</tbody>
</table>
Composing Messages
Click the **Messages** subtab open and view the messages in an SR.

You can send and receive attachments with the primary contact in the Customer Entry and Response messages. The partner contact can include an attachment with a Customer Entry message, and that attachment is visible to the internal resource. The internal resource can also share an attachment with the partner contact, by including the attachment in her Response message.

**Note:** The Customer Entry and Response messages are read-only for external partner roles.

The following table describes the types of messages that you can compose for an SR.

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Entry</td>
<td>In a partner SR, the Partner Account is the customer. Customer entries capture the information that the customers provide to explain their service problem or question. Depending on the input channel, this information might be written directly by the customer, or transcribed by the agent while interacting with the customer.</td>
</tr>
<tr>
<td>Forward</td>
<td>You can forward a note to any other user of the application through one of the two following options:</td>
</tr>
<tr>
<td></td>
<td>• Send an email notification.</td>
</tr>
<tr>
<td></td>
<td>• Post a note to the SR message history.</td>
</tr>
<tr>
<td>Internal Note</td>
<td>SR owners can use internal notes to communicate with other team members who have access to the SR. A partner user can’t create internal notes.</td>
</tr>
<tr>
<td>Response</td>
<td>You can compose a response message to communicate with the SR contacts. You can send the response to the contact in an email template, or post it to another channel through an Application Programming Interface (API).</td>
</tr>
</tbody>
</table>

Creating Contacts
You must create a partner contact only from the **Partners Administration** user interface. Don’t create a partner contact from the **Create Service Request** page. For more information about creating a contact, see Oracle Sales Cloud Implementing Sales Guide.

Creating a Team
This subtab is available only to internal users (customer service representative or channel account manager) with the View Service Request Team permission. To create the SR team, do the following.

1. On the **Edit Service Request** page, click the **Team** subtab.
2. In the **Team Members** subtab, click **Add Team Members**.
3. Search for and add team members to the team.

Creating Activities
This subtab is available only to internal users (customer service representative or channel account manager) with the View Service Request Team permission. Click the **Activities** subtab to create an appointment, create a task, or log a call from the **Activities** page. For more information about activities, see Oracle Sales Cloud Implementing Sales Guide.
Viewing Linked Articles
Click the **Linked Articles** subtab to view the knowledge articles that are linked to the SR. Linked articles are visible only if the administrator has configured and enabled the Knowledge feature. To view the linked articles, you must be an internal user (customer service representative or channel account manager) with the permission to view knowledge within a service request.

Viewing Milestones
The Milestone subtab is available only to internal users (customer service representative or channel account manager) with the View Service Request Team permission. This subtab on the **Edit Service Request** page lists all the milestones with the due dates and warning thresholds. You can filter the list to show the milestones you want to view. A red alert icon on the milestone indicates that it’s past its due date. A warning icon on the milestone indicates that it’s approaching its due date. Click the milestone to view more information. An icon indicating that the milestone was successfully completed appears when the milestone is complete. The milestone details display the thresholds set for the milestone and the current status of the milestone.

You can view the milestones in the table view or in the timeline view. The table view displays the completed and upcoming milestones in a table. The timeline view displays all the milestones in a timeline graph. Use the slider on the timeline to view the milestones by hours, days, weeks, or months. Milestones are updated and refreshed automatically. To refresh the milestone details manually, click **Actions** and select **Update Service Request Milestone Configuration**.

Creating and Editing Action Plans

Adding an Action Plan to an SR: Procedure
Add an action plan to a service request to help facilitate a series of steps that may be required to resolve SRs.

To add an action plan to an SR:

1. Create a service request.
2. On the Edit Service Request page, select **Add Action Plan** from the **Actions** menu.
3. Select a template from the list of templates, or search for a template using **Template** name, or **Category**.
   
   The action plan preview is displayed when the template row is highlighted to make sure the correct template is selected.
4. Click **Apply** to apply the action plan to the SR.
5. If one of the actions on the template is optional, you can skip the action by clicking the **Skip** icon. You can’t skip mandatory actions.

The following table shows the explanation of the columns of the action plan (in list-view) on the Edit Service Request Action Plan page.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>Order in which the action must be completed.</td>
</tr>
<tr>
<td>Action</td>
<td>Name and type of action. Actions can be:</td>
</tr>
</tbody>
</table>

- Task
## Column | Description
--- | ---
○ Activity  
○ Service Request  
○ Custom Object  |  
Status | Status of the action. In progress or Not Started  
Prerequisites | Number for the action that must be completed before the action can be started.  
Visibility | Visibility of the action. Internal actions are for internal use only. External actions can be seen by the customer.  
Owner | Name of the action’s owner.  
End Date | The projected date for the action to be completed as determined by the duration set by the administrator. The projected Completion date on the action plan is based on the action with the longest completion date.  
Optional and Skip | Available if you have permission to mark an action as optional, or skip the action entirely.

Now, that you have chosen a template, you can add additional actions to an action plan.

### Adding Additional Actions to the Action Plan

Optionally, you can add additional actions to an action plan:

1. Click the **Add (+)** icon.
2. On the **Add Actions to Action Plan** page, select an action from the list, or search for an action using **Action Name**, **Category**, or **Type**.
3. Click the **Add (+)** icon for the action you want to add.

You can add the same action multiple times. For example, if an action needs approval multiple times, add the action for approvals as many times as needed.

Remove an action from the Actions to Add pane by clicking the **Delete** icon.

4. Once you have added all the additional actions to the action plan, click **Add Actions**.

Actions added to the plan are inserted at the end of the plan and prerequisites can’t be added for any actions that aren’t added through a template.

**Caution:** Before you continue, make sure you have the correct plan and that all the actions are correct. After the plan is initiated, you can’t delete actions. To start over, click **Discard**. The **Discard** button is your last chance to remove the plan.

### Initiating the Plan

The final step is to initiate the plan.

1. Click **Initiate Plan** to start the plan.
Notice the actions now show the status and a projected completion date is displayed. In addition, any actions that don’t have a prerequisite are automatically moved to a status of In Progress.

2. You can now get started working on the plan.

Working with Action Plans

Use the Edit Service Request: Action Plan page to view and edit an action plan.

You can access and edit an action plan in two ways:

1. Click the Action Plan tab in the Edit Service Request page.

On the Edit Service Request: Action Plan page, you can do the following:

Filter Plans

You can use Quick Filter to view actions by:

- All Actions
- Active Actions
- Actions Delayed
- Actions without Prerequisites
- Actions Not Started
- Customer Visible Actions
- Blocked Actions

Editing Action Plans

You can edit actions in one of three ways:

1. Click the link of an Action name. It opens the related business object where you can make updates. For example, you can change status to Complete.
2. Update the End Dates if things are not getting done on time or if things are getting done early.

Working with the End Dates:

When an action is created, the estimated time it takes to complete a task is entered for the action. On an action plan, an end date for each action is based on the estimated time for the action.

If an action is past due, a warning icon appears on the end date of the action showing that the deadline for the action passed. In addition, the projected completion date shows a warning.

When an action is past due, all the dates for actions that are not started are not displayed. You can change the end date of an action by clicking in the End Date field for the action and changing the date. Click Refresh to refresh all the dates for the plan.

Once the date for the past-due action is corrected, the warning no longer appears and the end dates for all incomplete actions reappear.

3. Skip actions if they haven’t started yet.
If one of the actions in an action plan is optional, you can skip the action by clicking the Skip icon. You can't skip mandatory actions or change prerequisite actions.

To edit actions:

1. Access the action plan from the SR.
2. Click the link for the action you want to edit.
3. Use the Edit page to edit information for the action.

   Each tab in the Edit Task window contains information that can be edited for the action.

4. When you have completed edits to the action, click Save and Close to return to the Action Plan page.

Adding Actions

To add additional actions to an existing plan:

2. On the Add Actions to Action Plan page, select an action from the list, or search for an action using Action, Category, or Type.
3. Click the Add icon for the action you want to add.

   You can add the same action multiple times. For example, if an action needs multiple approvals, you can add the action as many times as needed.

Viewing Action Plans

View an action plan using the default list view, or select the Diagram view icon to see a graphical version of the action plan.

- List View: Displays a table with the steps in the action plan. You can sort the columns in the table using the arrows in each column header.
- Diagram View: Displays a graphical view of the action plan timeline. This view shows the status of each action. You can also hover over each action to show prerequisites, dates for the action, next steps, and the action’s owner.

FAQs about Action Plans

What's an Action Plan?

Action plans can be associated with service requests as a checklist for a series of events, or steps required for resolving service requests. You can add action plans to an SR using a predefined template, or by adding individual actions. Actions can be tasks, appointments, or service requests and are mandatory or optional.

To add an action plan to an SR, select Add Action Plan from the Actions menu in a service request.

Viewing Service Request Details
Viewing Interaction History for the Service Request

The Interaction History view is an agent or manager facing view of interactions that have taken place against a specific account, contact or service request. You can use the Interactions History tab to easily track all customer communications across channels.

On the Edit Service Request page, click the Interaction History tab to view all interactions that are recorded for the service request. This tab displays the total number of interactions, the most-used channels and contacts that were involved in the interactions.

You can filter the interactions by channel, contacts, resource, creation date, and direction of the interaction. Clicking the channel link from this view brings up the Wrap Up page. You can also open and view the chat transcripts from the Wrap Up page. The Interaction History tab also contains real-time analyses about the interactions for the SR. The following table lists and describes the analyses that are displayed in the tiles in the Interactions History subtab.

<table>
<thead>
<tr>
<th>Analyses</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactions</td>
<td>Provides an overview of the interactions volume for the SR. This tile displays the following information:</td>
</tr>
<tr>
<td></td>
<td>• Total number of interactions that have happened for that SR.</td>
</tr>
<tr>
<td></td>
<td>• Number of interactions over the last 10 days.</td>
</tr>
<tr>
<td>Top Channels</td>
<td>Shows which are the most used channels for interactions on the SR. This tile displays the number of interactions from the 3 most used channels.</td>
</tr>
<tr>
<td>Top Contacts</td>
<td>Shows the contacts that have been interacting the most on the SR. This tile displays the names of the 3 team users who have the most interactions, with the number of interactions from each.</td>
</tr>
</tbody>
</table>

You can view interactions that are linked to a service request, lead, and opportunity. These are indicated in the Reference Type column.

Viewing Audit History for a Service Request

If the Audit History tab is enabled by the administrator, it appears on the Edit Service Request page. The Audit History tab displays audit reports for the service request. You can filter the audit reports by date, user, and events.

You can export the audit report from the Audit History tab to excel. The following procedure describes how to access an audit report.

1. In the Audit History tab, select the date range for which you want the report.
2. Enter the other search details if required, such as user name and, event type.
3. Click Search.
4. In the Search Results, select the report you want by clicking on the appropriate row.
5. Click Actions and select Export to Excel.

You can save your search criteria by clicking Save in the Search section.
Using Oracle Social Network to Collaborate with Other Resources

Click the Social icon to collaborate on Oracle Social Network with other resources regarding the SR through conversations and sharing documents. You can start a new conversation or click the menu to select one of the options such as mark a conversation or create a user group.

**Note:** To allow access to the Oracle Social Network, the application administrator must enable the service request object sharing on the Oracle Social Network. The administrator can enable this object sharing through the Manage Oracle Social Network Objects in the setup tasks.

When you create an SR, on clicking the Social tab, you see the Share button that you must click to make it available on Oracle Social Network.

If you open an SR that is shared to Oracle Social Network by another user, on clicking the Social tab, you see the Join button. Click this button to join the conversation. Once you Join, the existing conversations become visible. When an SR is shared, updates about the SR are displayed on the conversation wall.

To start a new Oracle Social Network conversation about the SR, proceed as follows: open Oracle Social Network and click New Conversation. On the Create New Conversation dialog box, enter a conversation name and add the required members to it, and click OK. The new conversation appears in the list of conversations. For more information about using Oracle Social Network, see the Oracle Cloud Using Oracle Social Network guide.

*Related Topics*
- Adding Oracle Social Network in Oracle Sales Cloud: Overview
- Managing Oracle Social Network Objects: Explained

Viewing Milestones for Service Requests

When you create a service request, the related milestones are applied automatically based on the service entitlements assigned to the customer. Milestones indicate significant events in your service request resolution process and are based on the service level agreements defined for your business. These milestones help you identify your compliance with these agreements.

The Milestone tab on the Edit Service Request page lists all the milestones with the due dates and warning thresholds. You can filter list to show the milestones you want to view. A red alert icon on the milestone indicates that it’s past its due date. A yellow warning icon on the milestone indicates that it’s approaching its due date. Click the milestone to view more information. A green icon indicates that the milestone was successfully completed. The milestone details display the thresholds set for the milestone and the current status of the milestone.

You can view the milestones in the table view or in the timeline view. The table view displays the completed and upcoming milestones in a table. The timeline view displays all the milestones in a timeline graph. Use the slider on the timeline to view the milestones by hours, days, weeks, or months. Milestones are updated and refreshed automatically. To refresh the milestone details manually, click Actions and select Update Service Request Milestone Configuration.

Inserting Knowledge in Service Requests
Using Knowledge with Service Requests: Explained

You can use Knowledge to help solve service request (SR) issues. While creating or working in an SR, you can quickly insert relevant knowledge base articles into SR communications and send the information to the customers.

Accessing Knowledge while Creating an SR

You can access Knowledge while creating an SR to help resolve issues quickly and efficiently. While creating an SR, you can search for relevant knowledge base articles and add them to your Favorite Articles list.

To access knowledge:

1. At any point while you’re creating an SR, click the Restore Pane arrow and select the Knowledge tab.
   - The Search tab appears. The Search field automatically contains the title of the SR. You can also view the Favorite Articles tab.
2. Click the Search icon to search on the SR title or enter an alternate term. You can select a Locale and Filter By options to sort the search results. The locale is set to your language and territory preferences.
3. Select an article.
   - The article window displays the contents of the article.
4. Click Save and Continue to save the SR and continue editing.
5. Click Save and Close to save the SR and close it.

Searching for Articles

If you don’t find the article you want in the Recommended Articles section, you can search the knowledge base.

✏️ Note: You can also configure your locale to search articles in your preferred language.

To search for additional articles:

1. Expand the Search area in the Knowledge tab.
2. Enter the search term and click the Search icon.

Viewing Article Contents

To view the contents of an article:

1. Open an article.
   - The article title window displays the contents of the article such as publishing status, relevant products and categories, and other information.

Related Topics

- Adding a Favorite Article: Explained
- Configuring Knowledge Locales for Searching Articles
Inserting Knowledge into SR Messages: Explained

You can insert Knowledge articles as text into SR messages to resolve issues efficiently. You can add article contents to an SR directly from the Knowledge tab or from the Article Details window, or manually using the Insert Knowledge option in the Compose message pane within an SR.

Adding Articles as Text to SR from the Knowledge Tab and Article Details Window

You can add articles to SR from the Knowledge pane and from the Article Details window.

- **Note:** You can’t insert knowledge as text from the Knowledge pane, if the article is one of the following:
  - Unpublished
  - Not accessible

To add knowledge as text:

1. Open an SR in edit mode and click the Restore Pane arrow.
   - The Recommended Articles tab lists the articles based on the title of the SR. You can also locate an article from the Search tab or select an article from the Favorite Articles list.
2. Click the Insert knowledge article as text in a message icon from the list in the Knowledge pane or on the Article Details window.
   - The article is linked to the SR and is added as text in the Compose: Response pane in the Messages tab.

   - **Note:** You can add multiple articles as text to the Compose: Response tab.

3. (Optional) Select the appropriate Channel Type and add a personalized message if necessary.
4. Click Save as Draft to save the message as draft
5. Click Send to communicate the message through the appropriate channel.
   - The list of sent messages appears with the latest message first. You can also click Cancel to close the message without sending.

Manually Inserting Knowledge into SR Messages

You can manually insert linked articles into an SR to send the article contents to the recipients. If you want to send an article that is not in the Linked Articles list, you must first link the article to the SR and save it.

To insert articles into SR messages:

1. Open an SR in Edit mode and click the Messages tab.
2. Select the message type that you want to send from the Compose drop-down list.
   - The Compose: message type pane opens.
3. Click Insert Knowledge.
   - The Insert Knowledge window opens and the articles that are linked to the SR appear.

   - **Note:** If you have linked an article and want to insert it in the message, you must save the SR first.
4. Click the **Insert as Text** icon and then click **Done**.
   
   The article is added as text to the SR message.

5. Edit the article text if needed.

6. Click **Send**, or click **Save to Draft**.

### Linking Articles

To link an article to SR:

1. In edit mode, access Knowledge by clicking the **Restore Pane** arrow, then select the **Knowledge** tab.
   
   The **Recommended Articles** tab lists the articles based on the title of the SR and the product listed in the SR (if applicable). You can remove the product filter by clicking the check mark icon for the products listed in the tab.

2. Click the **Link** icon in the **Knowledge** tab to select the article you want to link to the SR.

3. After linking articles, click **Save** to save the SR.
   
   You must save the SR after you have linked an article, or it will not appear when you try to insert the article into an SR message.

### Viewing Linked Articles

To view articles that are linked to SR:

1. Click the **Linked Articles** tab in the SR.
   
   The **Linked Articles** window displays all articles linked to the SR.

   Click the **Delete** icon to remove a linked article from an SR.

### Using Productivity Tools

#### Using Keyboard Shortcuts

Keyboard shortcuts enable you to operate the application’s buttons and actions. These keyboard shortcuts are defined by your administrator. To view the keyboard shortcuts available, on the **Service Requests** page, click **Actions** and select **Show Keyboard Shortcuts**. You can also access the shortcuts from the keyboard using Ctrl+Alt+H.

The **Button Access** keys relocate the cursor or selection focus to specific, frequently-used, interface components, and execute the action on the page. The **Action Command** keys enable you to execute actions directly using keyboard shortcuts.

#### Button Access Keys

The usage of keyboard shortcuts for button access keys depends on the browser that you use. The following table lists the combinations you can use for the supported browsers.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Operating System</th>
<th>Key Combination</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Chrome</td>
<td>Linux</td>
<td>ALT + Key</td>
<td>Click</td>
</tr>
<tr>
<td>Google Chrome</td>
<td>Mac OS X</td>
<td>CONTROL + OPTION + Key</td>
<td>Click</td>
</tr>
</tbody>
</table>
To select the value in the **Category** and **Product** fields on the SR Summary page using only keyboard keys, do the following:

1. Press the Tab key until you get to the **Product** or **Category** field.
2. Press Alt+Down arrow key to open the list options.
3. Press Shift+Tab key to select the **Search** link and press Enter.
4. Press Tab to select the header row under Browse.

   **Note:** Press Shift+Tab to move out of the table.

5. Press the Down arrow key to highlight the record that you want to select.
6. Press Shift+Alt+K to click **OK**.
   The product or category is added to the field.

**Actions**

You can use the Alt+Control+Key keyboard shortcut combination for all actions on the user interface. This combination is applicable to both Windows and Mac OS X operating systems. Here, Key is the keyboard key defined for that particular action. The shortcuts are listed in the **Actions** drop-down list for each action on every page.

**Using SmartText in Service Requests**

A SmartText entry is a reusable fragment of text that you can insert in messages and fields. As a user, you can create Private SmartText entries or use the available Public SmartText entries in your service requests. You can use the SmartText tab by opening the Restore Pane arrow.

A SmartText entry can contain system variables and user-defined variables. System variables are created by administrators and can’t be edited or deleted. You can create, edit and delete user-defined variables for your private set of SmartText.
entries. To view the list of available variables, click **SmartText** and select **Manage SmartText**. Click the **User-Defined Variables** tab or **System Variables** tab on the Manage SmartText screen.

To create a user-defined variable, click **New** on the **User-Defined Variables** tab in the **Manage SmartText** page. A new row is added to the Variables table. Enter the name of the variable and select the substitution type. The substitution type defines what happens when a user chooses to enter the variable. You can select from the following substitutions:

- **Prompt**: Select this substitution type when you want to be prompted to select a value when the variable is inserted. When using an entry with a Prompt substitution, you’re prompted to select and enter the value of the variable in the field. For example, you create a prompt type variable for a Bug number. When the SmartText entry containing this variable is used, you’re prompted to enter the bug number in the field where the field requires a value.

- **Eval**: Select this substitution type to automatically evaluate and substitute the value of the variable in the text. For example, you assign Service Request as the object, and primary Contact as the attribute in the variable and insert this variable in your SmartText entry. When this SmartText entry is used, the primary contact listed for the service request is automatically substituted for the variable in the text field.

- **Value**: Select this substitution type when you want a particular value to be inserted as the variable. For example, you create a variable for My Name and insert the value as your name. When the SmartText entry containing this variable is used, the value is automatically substituted as the name value you add in the variable.

To edit a user-defined variable, select the variable and update as required. To delete a user-defined variable, select the variable and click **Delete Selected Variable**.

You can use rich text in your SmartText entry by enabling HTML. However, you can use entries with rich text only in the fields that are enabled to accept HTML.

**Creating a Private SmartText Entry**

You can create a SmartText entry for your own use. This SmartText entry is only visible to you and is saved in the Private Set tab.

To create a Private SmartText entry, do the following.

1. Click the **Create** icon on the Private Set tab.
2. On the New SmartText page, enter the following details:
   - Title of the SmartText entry.
   - The text that you want to insert.
   - To insert a variable in the text, type the at (@) symbol, then begin typing the variable name. You can click the Tab key to automatically complete the variable, or use the navigation arrows on your keyboard, then press the Enter key. The variable is inserted where the cursor stands in your text.
   - Select Use HTML to use rich text formatting in your SmartText entry.
   - Click **Save as Personal** to save the SmartText entry.
3. Click **Save**.

You can view and manage all your Private SmartText entries from the Private SmartText tab. You can add, duplicate, and delete your private set SmartText entries.

**Using a SmartText entry in your Service Request**

To insert a SmartText entry, you can type the # character. Type the keyword for the SmartText entry that you would like to insert and select from the results to insert the entry. Alternatively, you can open the SmartText tab on the SmartText panel to view all the available entries. Browse for the appropriate entry in the public and private SmartText list, and click the selected entry to insert it.
Managing Service Requests on Mobile

Managing Service Requests on Mobile

As a service representative, service manager, or a partner user, you can manage service requests (SRs) in your Oracle CX Cloud Mobile application. The mobile application is supported on iOS and Android devices.

To access your SRs, tap the main menu icon on your Oracle CX Cloud Mobile application. Then tap **Service Requests** in the navigation pane. The SRs list view displays a list of all open SRs. You can do the following in the SRs list view:

- **Search, filter, and sort SRs.** When you search for SRs, you can only view the ones that you have access to. For example, if you search for an SR to which you do not have viewing privileges, it doesn't show in the search results. If you’re a partner user, you can only view the partner SRs that are associated with your partner account.

- **Create and edit an SR.** After you create an SR, tap **Edit** to add further information to the SR.
  - The products and categories are filtered based on the **Business Unit** you select, if the HZ_ENABLE_MULTIPLE_BU_CRM profile option is set to Yes. For more information about multiple business units, see "Setting Up Service Business Units" under Related Topics.

- **Swipe an SR from the list for quick edit options.**

- **Tap an SR from the list and view the details of the SR.** In the SR details view, you can do the following, using the tabs in the global footer:
  - View and create activities such as appointments and tasks. Tap an appointment or task on the activity timeline to view details.
  - View and add contacts, team members, and accounts to the SR.
  - View and add messages to the SR.
  - View and add attachments to the messages and SRs. You can also download attachments from messages to the mobile device.
  - View the interaction history for the SR. You can’t create or edit interactions.
  - Interactions track inbound and outbound communications with a customer across channels such as SMS, phone, and email. Interactions can be created for an account, contact, or service request. An interaction is logged whenever the icons on the contact wheel are selected.
  - View the milestone history for the SR. You can filter the milestone list view. You can’t create or edit milestones.

Milestones represent the service level agreements (SLAs) of the service organization with its customers, and are tracked against the SRs. These SLAs define the commitments and deadlines for the resolution of SRs. This determines the quality of customer service and helps to track the performance against those commitments.

Alternatively, you can also view the open SRs for a specific account or contact. Navigate to the details view of the account or contact you want to view, and then tap the **Service Requests** tab.

Managing Push Notifications on Mobile

Push notifications about an event on service request (SR) objects are delivered to iOS and Android mobile devices.

As a service agent or manager, you receive push notifications on your mobile device about an event on service request (SR) objects, if your administrator enables the **Mobile Notifications** feature under **Setup and Maintenance > Notifications**. An
event on the SR triggers a notification to alert you to take the necessary actions. These events are specific trigger conditions relating to an SR, such as the following:

- SR is assigned
- SR is resolved
- SR is escalated
- Expired milestone

You can tap a notification to drill directly to the relevant service request.

An administrator defines notification triggers as groovy scripts in **Application Composer**, containing the conditions that must be met for each notification. Notifications are triggered when the defined conditions are met. For example, a trigger can be defined to send a notification when a high severity SR has been assigned to an agent. For information about notification triggers, see "Setting Up and Defining Groovy Notification Triggers" under Related Topics.

**Related Topics**

- Configuring Oracle CX Cloud Mobile: Explained
- Oracle CX Cloud Mobile: Overview
- Setting Up Service Business Units
- Setting Up and Defining Groovy Notification Triggers
3 Working with Queues

Managing Queues: Procedure

You use queues to group resources based on a specific criteria, such as product skills, language, time zone, or geographical location. For example, if you have two product lines that require specific support skills, you can create one queue for product line 1, the other for product line 2, and assign agents to these queues based on their product skills. An agent however, can redirect the service request to another resource. You can associate work items to a queue through the user interface or the Assignment Manager rules.

Note: An agent can be assigned to multiple teams and multiple queues at the same time. In such cases where one agent is associated with multiple queues, routing considers the work priority of individual queues, not across queues.

Types of Queues

Queues can be of the following types:

- Manual - Work items that have to be manually assigned to an agent by the Service Manager or another agent with appropriate permission. Agents can also assign work items to themselves.

- Automatic - Work items that are in the queue are automatically assigned to an agent. The agent must be associated with the queue, present and available to take the work, and have enough capacity to handle the work.

Presence is determined by whether an agent has signed in to the application. Availability is determined based on if an agent is ready to accept work orders.

Capacity is determined by the global capacity set by the administrator. For more information, see Setting Channel Capacity: Procedure.

Work items are assigned to a queue based on the rules that are set up through the Manage Service Assignment Rules task. For more information, see Set Rules for Queue Assignment: Procedure.

Note: Automatic queues must be used only if your administrator has enabled Omnichannel.

Default Queue

An automatic queue named Default is provided ready-to-use. This queue can't be modified or deleted. Resources and resource teams can be added to Default queue. The Default queue contains work items that do not match any of the defined assignment rules, and hence, can't be placed into any other queue.

Note: Default Queue is available only with Omnichannel. If Omnichannel is not enabled, there is no default ready to use queue.
Creating a Queue

To create a queue, perform the following steps:

1. Sign in to the home page as a service administrator or service manager.
2. Click Service object and then click the Queues object.
3. Click Create Queue.
4. In the Create Queue page, specify the Name of the queue.
5. Specify an optional Description.

   The Enabled check box is selected by default. This determines that the queue is active and can receive work items.

   The Distribution options determine if a queue is Manual or Automatic. A queue is Manual by default.

6. Do one of the following
   
   a. Click Save and Close to close the Create Queue dialog box after saving.
   b. Click Save and Continue to save the queue without closing the Create Queue dialog box. If you click Save and Continue, options to add resources and resource teams to the queue are displayed.

\[\text{Note:} \] During automatic work assignment, if an agent is assigned more than one queue, processing of work items from one queue doesn’t depend on the processing of work items from the other queues.

Editing a Queue

The following are the implications of editing the properties of an existing queue:

- If an active queue is disabled, the existing unassigned work items in the queue have to be assigned manually. The name of a disabled queue is no longer displayed for selection in any of the forms or dialog boxes throughout the interface.

\[\text{Note:} \] If a disabled queue has associated assignment rules, the Assignment Manager continues to assign work items to the disabled queue, without assigning an agent, like in a manual queue. Hence, ensure that you delete the associated assignment rules when you disable a queue.

- If an automatic queue is changed to manual, any new work items or existing work items in the queue are no longer automatically assigned, but must be manually assigned. The name of the queue continues to be displayed for selection.

- If a manual queue is changed to automatic, the existing work items at the time of the change are not routed automatically. These work items have to be assigned manually. However, any new work items that come into the queue after the change are automatically routed.

- Changing the name of a queue doesn’t affect the work items that are already in that queue. Assignment Manager continues to assign work items to the renamed queue, based on the existing assignment rules.

To edit an existing queue, do the following:

1. In the Queues list page, click a queue name.
2. In the Summary: Queue Name page, make the necessary edits.
3. Click Save and Close to close the window after saving, or click Save to save the changes without closing.
Deleting a Queue

You can’t delete queues that have the following features:

- Contain default queues
- Contain open work items
- Contain assignment rules associated with the queue

To delete a queue, do the following.

1. Open an existing queue.
2. Click **Actions** and then click **Delete Queue**.

**Related Topics**

- Setting Channel Capacity: Procedure
- Creating a Resource Team: Procedure
- Set Rules for Queue Assignment: Procedure

Adding Resources and Resource Teams to a Queue

**Video**

Watch: This video tutorial shows you how to assign service requests to queues. The content of this video is also covered in text topics.

**Procedure**

You use a queue to group resources based on a specific criteria. Hence, you add resources or a group of resources that match the criteria to handle the queue. To add resources or resource teams to a queue, do the following:

Sign in to the home page as a service administrator or a service manager. Click Service object and then click Queues object.

To add resources:

1. Click on the **Resources icon**.
2. On the Resources page, click **Add Resources**.
3. On the Add Resources page, enter the search criteria and click **Search**.
4. Select the resources from the search results.
5. Click **Apply** to add the selected resources to the queue and stay on the same page. Click **OK** to add the resources and exit the page.

To add resource teams:

1. Click the **Resource Teams** icon.
2. On the Resource Teams page, click **Add Resource Teams**.
3. On the Add Resources Teams page, enter the search criteria and click **Search**.
4. Select the resource teams from the search results.
5. Click **Apply** to add the selected resources to the queue and stay on the same page. Click **OK** to add the resources and exit the page.

The resources and the resource teams are added to the queue.

**Related Topics**
- Creating a Resource Team: Procedure

---

**Queues Dashboard: Explained**

The Queues dashboard enables you to view statistical data about all the queues, such as the assignment mode, number of agents assigned, and interactions that are waiting to be assigned in each queue. You can also drill down a queue and view information about the pending work items within the queue and their details. Based on this data, you can analyze and monitor routing. Using this dashboard, you can also manually move an interaction within a queue to another queue, or assign the work item to an agent.

Alternatively, a work item can be rerouted automatically based on an assignment rule. If you click reroute, the work item goes to a different queue if the rules have changed, or the properties of the work item have changed. If the work was previously routed manually, rerouting assigns the work to the queue which corresponds to the automatic rules.

Once a work item is assigned to an agent, it’s no longer listed on the Queue Dashboard.

**Note:** The Queues Dashboard page is refreshed depending on the value you select in the **Auto Refresh** drop-down list. The Queues Dashboard displays only pending interactions.

---

**Analyzing Queues**

The Queues dashboard displays the following information. The Queues table lists statistics about both real-time and non-real-time work items.

<table>
<thead>
<tr>
<th>Queue Detail</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Indicates the name of the queue</td>
<td>Click the Name link to open the Summary tab in the Queue Details window.</td>
</tr>
<tr>
<td>Description</td>
<td>Indicates the queue description text</td>
<td></td>
</tr>
<tr>
<td>Enabled</td>
<td>Specifies whether a queue is enabled or disabled</td>
<td>Select a value from the Show drop-down list to display Enabled, Disabled, or All queues.</td>
</tr>
<tr>
<td>Distribution</td>
<td>Specifies whether routing is automatic or manual</td>
<td></td>
</tr>
<tr>
<td>Created</td>
<td>Indicates the date and time when the queue was created</td>
<td></td>
</tr>
<tr>
<td>Agent</td>
<td>Specifies the number of agents that are assigned to the queue, individually or as a part of a resource team</td>
<td></td>
</tr>
<tr>
<td>Queue Detail</td>
<td>Description</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resource</td>
<td>Indicates the number of resources that are assigned to the queue</td>
<td>Click the Resource link to open the Resources tab in the Queue Details window</td>
</tr>
<tr>
<td>Resource Teams</td>
<td>Indicates the number of resource teams that are associated with the queue</td>
<td>Click the Resource Teams link to open the Resource Teams tab in the Queue Details window</td>
</tr>
<tr>
<td>Assigned</td>
<td>Specifies the number of work items that are assigned to an agent</td>
<td>This value changes depending on the option that is selected from the Time Interval drop-down list. For example, to see the number of interactions that were assigned in the last 4 hours, select 4 Hours from the Time Interval drop-down list.</td>
</tr>
<tr>
<td>Waiting</td>
<td>Indicates the number of work items that are currently waiting to be assigned, in the specified time interval</td>
<td></td>
</tr>
<tr>
<td>Received</td>
<td>Specifies the number of work items that came into the queue in the specified interval of time</td>
<td>This value changes depending on the option that is selected from the Time Interval drop-down list. For example, to see the number of interactions that were received in the last 8 hours, select 8 Hours from the Time Interval drop-down list.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>Indicates the number of work items that were abandoned in the specified interval of time</td>
<td>This value changes depending on the option that is selected from the Time Interval drop-down list. For example, to see the number of interactions that were abandoned in the last 2 hours, select 2 Hours from the Time Interval drop-down list.</td>
</tr>
<tr>
<td>Real-Time Capacity</td>
<td>Specifies the percentage of the total capacity that is available to handle real-time work assignments</td>
<td></td>
</tr>
<tr>
<td>Non-Real-Time Capacity</td>
<td>Specifies the percentage of the total capacity to handle non-real-time work assignments</td>
<td></td>
</tr>
</tbody>
</table>

To view detailed information about the work items within a queue, select a queue record. When you select a queue, the relevant details are displayed in the Channel Summary and Interactions grids.

### Channel Summary

The Channel Summary for a queue displays data related to all the real-time work items in the queue. This table lists the following details.

<table>
<thead>
<tr>
<th>Channel Detail</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-Time Channel</td>
<td>Indicates the type of a real-time channel.</td>
<td></td>
</tr>
</tbody>
</table>
## Interactions

The interactions grid displays details about all of the interactions of the selected queue. However, this grid lists only real-time interactions by default. To display non-real-time interactions, select the **Show Nonreal-Time** option. The Interactions grid lists the following details.

<table>
<thead>
<tr>
<th>Interactions Detail</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction</td>
<td>Indicates the date and time when the interaction was created.</td>
<td></td>
</tr>
<tr>
<td>Channel</td>
<td>Specifies the type of communications channel.</td>
<td></td>
</tr>
<tr>
<td>Reference ID</td>
<td>Indicates an identifier of the work item that is associated with the interaction, for example, SR number.</td>
<td></td>
</tr>
<tr>
<td>Customer</td>
<td>Specifies the customer who started the interaction</td>
<td></td>
</tr>
</tbody>
</table>
Reassigning and Rerouting of Interactions: Procedure

You can move an interaction to another queue, assign the interaction to an agent, and also reroute an interaction using the Queues dashboard. To reassign and reroute an interaction, perform the following procedure.

1. Sign in to Oracle applications as a service administrator or service manager.
2. Navigate to the Queues dashboard.
3. Select a queue in the dashboard.
4. In the Interactions table, select an interaction to move, reassign, or reroute.
   
   - To move an interaction to another queue, select a queue in the Move To drop-down list and click Move. The interaction is manually assigned to another queue.
   - To manually assign the interaction to a specific agent, select an agent from the Assign To drop-down list and click Assign. Note the following when you manually assign an interaction.
     
     - This assignment is forced, which means that the interaction is assigned to an agent irrespective of the current capacity of the agent. With real time interactions however, the agent can decline the interaction.
     - The agents listed in the Assign To drop-down list include offline agents as well. Hence, an administrator must confirm presence and availability of an agent before assigning real-time interactions.
   - To reroute an interaction automatically, click Reroute. The interaction is assigned a queue based on the assignment rules. For example, if a critical interaction is rerouted and there is an assignment rule that reassigned all critical interactions to a specific queue, the rerouted interaction is automatically assigned to the queue for critical interactions.

When an interaction is moved or rerouted, the Wait Time value is reset. You can view the overall age of an interaction by analyzing the interaction data that displays the date and time when the interaction was first created.
4 Managing Notifications and Interactions

Using Chat

Using Chat

The chat feature enables you to interact with customers through chat and help resolve their issues from the chat window. The chat service is integrated with Digital Customer Service. A customer initiates a chat from the Digital Customer Service portal, and a notification is sent to the available service representatives in Engagement Cloud. The assigned service representative can then respond to the customer using the Live Window that opens in a new browser window.

You must set your availability on the toolbar for receiving chat requests.

Setting Availability

To set your availability for chat:

1. On the Service Requests List window, navigate to the chat icon in the toolbar.
2. Move the mouse over the chat icon to view the tool tip that displays your availability status for chat.
3. Click the chat icon in the toolbar to be available for chat.

The tooltip displays: Available for chat interactions. The chat function is enabled.
4. When you do not want to be available for chat, click the chat icon again to turn off your availability status.

When you set your availability, Live Window opens in a new browser window. You can manage your chats in the Web Channels tab in the Live Window. If you have the Live Window open, the Incoming Chat notification for a new chat appears in the Live Window, otherwise it appears on the desktop.

Note: An incoming new chat request notification is displayed for 30 seconds. An incoming new chat message notification is displayed for 5 seconds. The default time-out duration for chat inactivity is 30 minutes.

Managing Chats

When a customer initiates a chat request, an incoming chat window appears with the name and email of the person requesting the chat. The timer on the incoming chat window indicates the amount of time you have to accept or decline the chat. If the timer runs out, the chat is routed to another agent in the queue.

When you accept the chat, the Contact Verification window appears with the contact details. Click Verify and Continue, and the corresponding contact record is displayed, where you can view the contact details. To view the Live Window again, click the interactions icon on the toolbar. The interactions icon on the toolbar also displays the number of active interactions that you have.

Note: If the Engagement Cloud screen isn’t active, an HTML notification is also displayed in the task bar.

If you want to transfer the chat to a queue, click the transfer icon in the Live Window so that another agent can handle the chat.

After you accept the chat, you can engage in a conversation with the customer.
Wrapping up a Chat: Procedure

When a chat ends, the **Chat Wrap Up** window is displayed if chat wrap-up is enabled. You must record the details of the chat in this window. The chat details are captured and stored in a wrap-up record.

The wrap up details enable you to track the progress of a service request and also provide detailed interaction history. The wrap up details include contextual information and other details as follows:

- Total interaction time and channel type icon
- Agent who first handled the interaction
- Account name, title, email, and telephone number
- Reasons for the chat
- Whether the issue was resolved
- Any interaction notes that you want to enter

The wrap up page also displays all the business objects that were updated during the interaction, which can include one or more service requests. The associated items are displayed as links of the titles of the service requests.

A complete chat transcript between you and the customer is also captured and saved in the interaction wrap-up record or associated service request message. The chat transcript is correctly associated with the corresponding service request only if one of the following conditions are met:

- The service request account details match with the account details of the customer contact who initiates the chat.
- The primary contact for the service request initiates the chat.
- The agent who interacts with the customer on chat is the same agent who last updated the service request.

To wrap up a chat, perform the following steps in the **Chat Wrap Up** window:

1. Specify a **Communication Reason** by selecting an option from the drop-down list.
2. Select a **Resolution Code** to specify the type of resolution that was provided.
3. Specify a **Transfer Reason** if you transfer the chat to another agent for resolution.
4. Enter **Interaction Notes** to specify the details of the issue and the resolution that was provided. You can also document any other details that must be mentioned as part of the service interaction record.
5. Click **End Wrap Up**.

If the **Chat Wrap Up** window times out before you enter all the details, or if you want to add further notes, you can add them later.

Viewing Chat Wrap Up and Transcript

Use the Interaction History tab to view the wrap-up details and chat transcript. You can open the Interaction History tab from the Account, Contact, and Service Request record. To view the details and transcript, drill into the associated wrap-up record for the chat interaction. The **Chat Wrap Up** window displays the chat details.

✏️ **Note:** To view the chat transcript, click **Show Transcript** in the **Chat Wrap Up** window.

Handling CTI Notifications
Handling Call Notifications: Procedure

When an incoming call is detected, the notification goes through the following stages.

1. An agent is notified of an incoming call through a toolbar notification, and if configured, through a notification message box. If the agent is on another window other than the Oracle applications window, a toast notification is also sent to the agent.

2. When you accept the call, call controls enable you to put a call on hold, end a call, or transfer the call to another agent.

   After you accept a call, if the phone number of the incoming call is registered or if the details provided through the IVR are recorded in the database, basic customer details are displayed in the Contact Verification page.

3. If the customer details specified by the caller matches with the details on the Contact Verification page, click Verify and Continue. If the customer details don’t match, click Search Again. In the Contact Search page, search for a contact or create a new contact if the record doesn’t exist. For more information, see Searching for a Contact: Procedure. After a new records is selected, the Contact Verification page is displayed again with the new record. Verify the record.

4. After verification, screen pop is displayed with the service details of the customer. Add or modify details.

5. After the call ends, the Wrap Up page is displayed, if enabled. Enter the call resolution details on the page and click Save and Close. If the wrap-up is timed, you must wrap up before the specified time. If the time runs out, you can specify the wrap-up details in the interaction history of the customer record.

All incoming and outgoing calls are recorded in the interaction history of the customer record.

Searching for a Contact: Procedure

Computer Telephony Interface (CTI) contact search enables an agent to search for a contact when there is an incoming call. The contact search enables an agent to do the following:

- Search for the contact record of the caller by specifying a contact attribute, such as a phone number or an email ID.
- Select a contact record from a list of records that are displayed based on a prefilled caller information, such as a phone number. This information can be derived from an IVR system.
- Create a new contact if the caller record is not found.

Perform the following steps when there is an incoming call and the contact search is displayed:

1. If data is prefilled in the contact search and multiple matching records are displayed, select a relevant contact.
2. If there is no single matching record is found, enter details based on the information given by the caller and click Search. Select a record if any.
3. If there is no record of the caller in the database, click Create Contact to create a new record. Enter details and click Save and Close.

To save a search, click Save in the Search Results pane. You can run a saved search by selecting the search from the Saved Searches drop-down list.

Related Topics
- Modifying the Default Contact Search: Procedure
Wrapping Up an Interaction: Procedure

At the end of a service call or chat, a Wrap Up page is displayed to the agent, if the option has been enabled by the administrator. You use the Wrap Up page to record the details of the call or chat.

The Wrap Up page is used to capture the agent’s closing interaction notes and contextual information. This page can be configured to ensure that the agent can capture relevant information. The ready to use Wrap Up page captures the following information:

- reason for call
- resolution code and
- interaction notes.

Contextual information such as contact name, phone, email, and title enable the agent to easily keep track of the wrap-up for which they are providing information.

The Wrap Up page also displays all the business objects that were updated during the interaction, which can include one or more service requests. The associated items are displayed as titles of the service request and are links.

Perform the following steps in the Wrap Up window.

1. Specify a Communication Reason by selecting an option from the drop-down list.
2. Select a Resolution Code to specify what is the type of resolution that was provided.
3. Specify a Transfer Reason if you transfer the call is to another agent for resolution.
4. Enter Interaction Notes to detail the issue and resolution provided. You can also document any other details that must be mentioned as part of the service interaction record.
5. Click End Wrap Up.

An administrator can configure the Wrap Up page using the application composer to enable the fields that must be presented to the agent.

If the Wrap Up window is timed out before you enter all the details, navigate to the relevant service request, open the Interaction History, select the latest interaction, and complete the wrap-up details.

Note: When a call originates from a service request click-to-dial, or if the screen pop was to a service request, the wrap-up details are stored as service request messages within the relevant service request record.

Setting Agent Availability and Presence

Setting Presence and Availability: Explained

Once you sign in to the application, you must set your presence and availability on the user menu. Work assignment is done based on these factors.

Agent availability indicates if you’re available to handle an interaction. You can explicitly specify availability for real-time and non-real-time work items. This means that you can specify if you’re available for chat or for SR assignment, or both. Based on the availability of an agent, work items are assigned. As soon as you sign in to the application, you’re available for non-real-time interactions, by default.
Presence indicates if you have sign in to the application and are interacting with the application. Set the presence using the **Settings and Action** menu within the Oracle Cloud application. Your status can be Available, or Busy. You can toggle between statuses. The following table illustrates the work assignment based on availability and presence.

<table>
<thead>
<tr>
<th>Accepting Work</th>
<th>Presence</th>
<th>Work Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-real-time</td>
<td>Available</td>
<td>SR is routed to the agent</td>
</tr>
<tr>
<td></td>
<td>Busy</td>
<td>SR is routed to the agent and a notification is displayed. If time-out period is nearing, a bold notification is displayed. You can click the notification and accept the assignment. If you’re busy for an extended period of time, the SR is assigned to another agent. The availability to receive non-real-time work is turned off.</td>
</tr>
<tr>
<td>Non-real-time</td>
<td>Offline</td>
<td>If you’re signed out of the application, your status is set to offline. No new SRs are assigned, but the SRs that are already assigned are still owned by the agent.</td>
</tr>
<tr>
<td>Real-time</td>
<td>Available</td>
<td>Chat notifications are sent to the agent.</td>
</tr>
<tr>
<td>Real-time</td>
<td>Busy</td>
<td>Chat availability is turned off.</td>
</tr>
</tbody>
</table>

### Bell Notifications for Service Requests

**Bell Notifications for Service Requests: Explained**

An event on the service request (SR) triggers a notification to service agents and managers, to alert them to take the necessary actions.

Events are specific trigger conditions relating to a service request, such as the following:

- SR is assigned
- SR is resolved
- SR is escalated
- Expired milestone

The **Notifications** icon on the global header displays the number of unread notifications. Clicking the **Notifications** icon lists all notifications. You can click a notification to take further action. Clicking a notification and navigating to the record details marks the notification as read, and it is cleared from the notification list.

Notifications can be enabled by an administrator through the **Notifications** feature in **Setup and Maintenance**. When the **Notifications** feature is enabled, bell notifications are automatically enabled for service requests. An administrator defines notification triggers as groovy scripts in **Application Composer**, containing the conditions that must be met for each notification. Notifications are triggered when the defined conditions are met. For example, a trigger can be defined to send a
notification when a high severity SR has been assigned to an agent. For information about notification triggers, see "Setting Up and Defining Groovy Notification Triggers" under Related Topics.

Related Topics

- Setting Up and Defining Groovy Notification Triggers
5 Managing Work Orders

Work Orders: Overview

A work order could be related to an install, standard maintenance, repair request, or any work that must be performed at the customer site.

A work order includes the following information:

- Customer contact information
- Information about the location where the work is to be performed
- Type of work to be performed
- Date and time to execute the work
- Product and maintenance details necessary for completing the work
- The person to whom the work order is assigned

Creating a Work Order: Procedure

To create a work order for a service request do the following:

1. Open the service request.
2. Click the Work Order tab.
3. Click the Create Work Order button.
4. Select a contact from the list of values.
5. Enter the relevant information in the fields using the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>The contact’s primary phone is automatically populated if the contact has a primary phone. If the contact has another phone, use Other Phone from the list of values to select an alternate phone. If needed, you can make changes to the contact’s information by clicking the Manage Phone link in the list of values.</td>
</tr>
<tr>
<td>Email</td>
<td>The contact’s email is automatically populated if the contact has a primary email. If needed, you can change or add the contact’s email by clicking the Manage Email link in the list of values.</td>
</tr>
<tr>
<td>Address</td>
<td>The contact’s address is automatically populated if the contact has a primary address. If the physical address where the work is being performed is different from the primary address, use the list of values to find the physical address. If the address doesn’t exist in the list, you can add it by clicking the Manage Address link in the list of values.</td>
</tr>
</tbody>
</table>

6. Select the Time Zone for where the work is being performed.
7. Select the Work Order Area from the list of values.
8. Select the Type of Work to be performed from the list of values.
9. Optionally, enter a time (in minutes) for a Reminder to the customer.
The reminder triggers the service representative to contact the customer to confirm the time that the technician is scheduled to perform the work.

10. Click the Calendar icon in the Requested field. The calendar appears with information based on the work order type and work order area.

If there is a service level agreement (SLA) and you select a time that is outside the resolution due, a warning message appears to let you know the time is outside the SLA.

11. Select a date and time slot on the calendar for when the work should be completed.

If a resolution due is assigned from the SR, then you aren’t required to select a time slot. If you select a time slot, it will override the resolution due. If there is no resolution due from the SR, then a time slot is required to save the work order.

12. Click Select.

You’re taken back to the Create Work Order page.

Notice the Requested field is now populated with the time and date you selected on the calendar.

13. Optionally, enter a Case Note for the technician.

14. Click Save and Close.

A confirmation message appears with the work order number. You can use that work order number for future searches.

15. Click Refresh on the Work Order page to validate the work that is scheduled.

The work order is now created.

Related Topics

- Creating and Editing a Service Request: Procedure

Updating a Work Order: Procedure

To update a work order do the following:

1. Open the service request.

2. Click the Work Order tab.

3. Click the work order number that you want to update.

4. Update the work order with your changes.

5. Click Save.

A confirmation message appears showing the change was submitted.

6. Click Refresh to see change confirmation. The work order is in read-only mode until Oracle Field Service Cloud application acknowledges the change. This should only take a moment. When the change is confirmed, the Edit Work Order page appears with the change displayed.

7. Click Save and Close.

The work order was successfully changed.
Rescheduling a Work Order: Procedure

To reschedule the date or time for a work order do the following:

1. Open the service request.
2. Click the Work Order tab.
3. Click the number of the work order that you want to reschedule.
4. Click the link for the Requested Time and Date. You can also click the Calendar icon.
5. Select a new date and time on the calendar.
6. Enter a reason for rescheduling the work order.
7. Click Select.
8. Click Save.

Integration Cloud Services must now confirm rescheduling.
9. Click Refresh to see if rescheduling is confirmed. The work order is in read-only mode until Oracle Field Service Cloud acknowledges the change. Once rescheduling is confirmed, the Edit Work Order page is returned and the information for Requested and Scheduled match.

_WARNING: Rescheduling failures can be caused by the following:
- Rescheduling was rejected by TOA.
- Integration Cloud Services didn’t connect to TOA. An administrator must manually reschedule the work order.

10. Click Save and Close.

The work order was successfully rescheduled.

Canceling a Work Order: Procedure

To cancel a work order do the following:

1. Open the service request.
2. Click the Work Order tab.
3. Click the number of the work order that you want to cancel.
4. Click Cancel Work Order.

A warning message appears letting you know that you can’t reopen canceled work orders.
5. Enter the Cancel Reason.
6. Click Cancel Work Order.

The work order is in read-only mode until Oracle Field Service Cloud acknowledges the cancellation.

A confirmation message appears.
7. Select Show from the list of values. Select Canceled Work Orders. Verify the work order was canceled.
Viewing Audit History for a Work Order

The Audit History tab on the Edit Work Order: Summary page displays the audit reports for the work order. You can filter the audit reports by date, user, and events.

To view audit history for a work order do the following:

1. In the Edit Work Order: Summary page, click the Audit subtab.
2. Expand the Search region and select the date range for which you want the report.
3. Enter the other search details if required, such as User Name and, Event Type.
4. Click Search.
5. To export the report, click the Export to Excel icon, or click Export to Excel from the Actions menu.

You can save your search criteria by clicking Save in the Search region.
6 Using Service Analytics

Service Analytics: Explained

Oracle Transactional Business Intelligence (OTBI) is a real time, self-service reporting solution bundled with Oracle Engagement Cloud. It provides prepackaged analytic content built on the Oracle Business Intelligence (BI) platform.

The following topics detail various options to view prebuilt analytic content and to build your own content using subject areas.

Viewing Prebuilt Infolets and Detailed Reports

The following task applies to all roles and is performed on the Service Infolets page.

1. From the page control on the Home page, click the Service Infolets icon.
   
   The Service Infolets page is displayed. It displays the Infolets enabled for the signed in role.

2. Click any individual infotile to view a detailed report.

Viewing Your Favorite Reports

The following task applies to all roles and is performed on the Analytics page.

Note: The Analytics icon must be enabled by an administrator.

1. From the springboard on the Home page, click Service, and then click Analytics.

2. On the Analytics page, perform a keyword search on the reports in the BI Catalog.

3. View reports in either a list or a carousel view.

   Optionally, you can mark reports as favorites that you want to access quickly later. This page also shows the analytics recently viewed by the signed in user.

Viewing All Analytic Content

The following task applies to all roles and is performed in the BI Catalog and the Reports and Analytics page.

To view all analytic content using the BI Catalog, do the following:

1. Click Navigator > Tools > Reports and Analytics.
   
   The Reports and Analytics page is displayed.

2. Click Browse Catalog.
   
   The BI Catalog is displayed.

3. View the list of the reports and dashboards under the Shared Folders > Service > Embedded Content and Shared Folders > Service > Subject Area Content folders.

   Administrator-defined or user-defined content is displayed under the Shared Folders > Custom folder.

   Personal content available only to you is displayed under the My Folders folder.
To view all analytic content using the Reports and Analytics page, do the following:

1. Click **Navigator > Tools > Reports and Analytics**.

   The Reports and Analytics page is displayed.

2. Click the **Hierarchical Selector >>** icon, and select **My Folders** or **Shared Folders** from the menu.

   The list of reports and dashboards is displayed, without navigation to BI Catalog. Similar to the Analytics page, you can perform a keyword search and mark your favorites, which persist for easy access later.

### Creating Quick Analyses

The following task applies to all roles and is performed on the Reports and Analytics page.

1. Click **Navigator > Tools > Reports and Analytics**.

   The Reports and Analytics page is displayed.

2. Click the **Create** drop-down button and select **Analysis**.

   The **Select Subject Area** window is displayed.

### Creating Analyses

The following task applies to the Administrator and Customer Service Manager roles and is performed in the BI Catalog.

1. Click **Navigator > Tools > Reports and Analytics**.

   The Reports and Analytics page is displayed.

2. Click **Browse Catalog**.

   The BI Catalog is displayed.

3. From the **New** menu, select **Analysis**.

   The **Select Subject Area** pane is displayed.

### Creating Production Reports

The following task applies to the Administrator and Customer Service Manager roles and is performed on the Reports and Analytics page and BI Catalog.

> **Note:** Advanced Users use the BI Publisher tool to create pixel perfect reports. This tool is not recommended for creating OTBI reports that can otherwise be created using OBIEE Answers.

To create production reports using the Reports and Analytics page, do the following:

1. Select **Navigator > Tools > Reports and Analytics**.

   The Reports and Analytics page is displayed.

2. Click the **Create** drop-down button and select **Report**.

   The **Create Report** window is displayed.

To create production reports using the BI Catalog, do the following:

1. Select **Navigator > Tools > Reports and Analytics**.
The Reports and Analytics page is displayed.

2. Click **Browse Catalog**.
   The BI Catalog is displayed.

3. From the **New** menu, select **Published Reporting > Report**.
   The **Create Report** window is displayed,

### Using Service Analytics: Explained

This section describes the Service infolets for the customer service representatives, customer service managers, help desk agents, and help desk managers.

#### Service Infolets

The following tables list and describe the Service infolets.

A customer service representative and help desk agent’s Service Infolets page includes the infolets listed in the following table.

<table>
<thead>
<tr>
<th>Infolet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Resolve Time</td>
<td>Shows the average time taken by the user to resolve the service requests that are assigned to the user, in the last 30 days. In addition, it displays the average time taken by all agents to close the service requests assigned over the last 30 days. This information compares the user’s average time with the average time taken by all agents together over the last 30 days.</td>
</tr>
<tr>
<td>Pending Tasks</td>
<td>Displays the number of pending tasks that are assigned to the user and contains the following information:</td>
</tr>
<tr>
<td></td>
<td>• Tasks that are of high priority</td>
</tr>
<tr>
<td></td>
<td>• Tasks that are of medium priority</td>
</tr>
<tr>
<td></td>
<td>• Tasks that are of low priority</td>
</tr>
<tr>
<td></td>
<td>• Tasks that are past their due date</td>
</tr>
<tr>
<td>Waiting on Customer</td>
<td>Displays an overview of the service requests that are waiting on the customer and contains the following information:</td>
</tr>
<tr>
<td></td>
<td>• Number of service requests in the Waiting status.</td>
</tr>
<tr>
<td></td>
<td>• Number of service requests that are resolved.</td>
</tr>
<tr>
<td></td>
<td>• Total number of service requests assigned to the user, which includes both resolved requests and requests waiting on the customer.</td>
</tr>
<tr>
<td></td>
<td>• Total number of critical service requests assigned to the user, which includes both resolved requests and requests waiting on the customer.</td>
</tr>
<tr>
<td>Waiting on Me</td>
<td>Displays an overview of the service requests that are waiting on the user. The infolets contain the following information about the service requests waiting on the user:</td>
</tr>
<tr>
<td></td>
<td>• Number of new service requests.</td>
</tr>
<tr>
<td></td>
<td>• Number of service requests that are in progress.</td>
</tr>
<tr>
<td></td>
<td>• Total number of service requests that are awaiting a response from the user and are in progress.</td>
</tr>
</tbody>
</table>
A customer service manager and help desk manager’s Service Infolets page includes the infolets listed in the following table.

<table>
<thead>
<tr>
<th>Infolet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My SR Compliance</td>
<td>Displays an overview of all the milestones and their status on the service requests assigned to the user. This infolet contains the following information about the service requests milestones for the user:</td>
</tr>
<tr>
<td></td>
<td>• Number of SRs assigned to the user that have milestones that are nearing their due date.</td>
</tr>
<tr>
<td></td>
<td>• Number of SRs that are assigned to the user where the milestone due dates have passed.</td>
</tr>
<tr>
<td></td>
<td>• Number of SRs that are nearing and already have noncompliance issues with milestones.</td>
</tr>
<tr>
<td></td>
<td>• The number of SRs that have a critical status.</td>
</tr>
<tr>
<td>My Open Work Orders</td>
<td>Shows a listing of open work orders assigned to the signed in user, which are expected to be noncompliant, where the estimated end date is past the resolution due date. A listing of work orders that are noncompliant (where the actual end date is past the resolution due date), and are expected to be compliant, can also be optionally viewed.</td>
</tr>
<tr>
<td>My Completed Work Orders</td>
<td>Shows a listing of noncompliant work orders assigned to the signed in user, where the actual end date is past the resolution due date. Compliant work orders can also be optionally viewed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Infolet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents with Most Pending Service Requests</td>
<td>Displays the top-three agents that have the most pending service requests, and the number of service requests that are pending. Pending service requests are requests that are in a New or In progress state, and are pending action by the agent. These requests don’t include the requests that are waiting on the customer.</td>
</tr>
<tr>
<td>Long Wait on Agent</td>
<td>Number of service requests that are waiting on the agent for longer than 24 hours.</td>
</tr>
<tr>
<td>Queues by Unassigned Service Requests</td>
<td>Number of unassigned service requests in each queue. The graph also displays the priority of the service requests in the queues.</td>
</tr>
<tr>
<td>Team Resolve Time</td>
<td>The average resolution time of the service requests resolved in the last 30 days, by any user in the signed-in service manager’s team. The time is displayed in the number of days, hours, and minutes.</td>
</tr>
<tr>
<td>Critical Service Requests</td>
<td>The average resolution time of the service requests resolved in the last 30 days, by any user in the signed-in service manager’s team.</td>
</tr>
<tr>
<td>Team SR Compliance</td>
<td>Displays an overview of all the milestones and their status on the service requests assigned to the team. This infolet contains the following information about the service requests milestones in the team:</td>
</tr>
<tr>
<td></td>
<td>• Number of SRs assigned to the team that have milestones that are nearing their due date.</td>
</tr>
<tr>
<td></td>
<td>• Number of SRs that are assigned to the team where the milestone due dates have passed.</td>
</tr>
<tr>
<td></td>
<td>• Number of SRs that are nearing and already have noncompliance issues with milestones and are assigned to the team members.</td>
</tr>
<tr>
<td></td>
<td>• The number of SRs that have a critical status.</td>
</tr>
<tr>
<td>Inbound Emails</td>
<td>Shows the total number of inbound emails during the past 30 days. A breakdown of this total by the number that resulted in SR creations, SR updates, and number of emails that failed is also shown.</td>
</tr>
<tr>
<td>Infolet</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Inbound Social Posts</td>
<td>Shows the total number of social posts during the past 30 days. A breakdown of this total by the number that resulted in SR creations, SR updates, and number of posts that failed is also shown.</td>
</tr>
<tr>
<td>Omnichannel Agent Assignments</td>
<td>Shows the top-five agents with the most work assignments during the past seven days.</td>
</tr>
<tr>
<td>Omnichannel Assignments</td>
<td>Shows the top-five queue assignments by channel type for the past seven days.</td>
</tr>
<tr>
<td>Omnichannel Queue Assignments</td>
<td>Shows the top-five queues with the most work assignments during the past seven days.</td>
</tr>
<tr>
<td>Team Open Work Orders</td>
<td>Shows a listing of open work orders assigned to the signed in user and the user’s subordinates, which are expected to be noncompliant, where the estimated end date is past the resolution due date. A listing of work orders that are noncompliant (where the actual end date is past the resolution due date), and are expected to be compliant, can also be optionally viewed.</td>
</tr>
<tr>
<td>Team Completed Work Orders</td>
<td>Shows a listing of noncompliant work orders assigned to the signed in user and the user’s subordinates, where the actual end date is past the resolution due date. Compliant work orders can also be optionally viewed.</td>
</tr>
</tbody>
</table>

For more information about Analytics, see Related Topics.

**Related Topics**

- Oracle Sales Cloud Creating and Administering Analytics for Sales